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About HLServer

HLServer is the headus floating license server.

Figure 1. Example setup

Figure 1 shows an example installation; the server is running on sgibox, with two cyslice licenses issued to
applications running on sgibox2 and ntbox. Also shown is the license manager, hlmanager which the system
administrator can use to remotely control some aspects of the operation of the license server.

The link between the license server and applications is via connected TCP/IP sockets. This means that a
connection has to be maintained at all times during the life of an application, and if its broken the application
loses its license and will exit. See Application Restore for details on how users can enable the restore function.

Compared to Node-Locked Licenses

When a host is issued a node-locked license, any number of users can run any number of associated
applications on that host. For example, with a single cyslicev3 license, any number of CySlices and PlyTools
can be run on the licensed host. In fact, CySlice itself is really two applications - the GUI and the graphics
window are separate programs - and so when running just one CySlice you are running at least two programs
off the one license.

Floating licenses have been designed to operate in the same way. The first application to run on a host will
grab the first available floating license. More applications can then be run on that host without the need to
grab more licenses; they will attach themselves to the first floating license. Even if the first application exits,
as long as some applications are running, the floating license will still be in use.

For example, if Cyslice is run from a floating license, it will grab the first available cyslicev3 license. If
PlyTool is then run, it will attach itself to the cyslicev3 license and be able to run. Only one floating license is
in use even though two applications are running.

If the user then exits from CySlice, PlyTool still has the floating license and continues to run. What they
shouldn't do then is lock their office and go on a holiday because no-one else will be able to use that floating
license while they are away! Fortunatly, the license manager lets sysadmins and other trusted users reclaim
licenses that have been grabbed but not returned.
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Choosing a Server Host

The following is a list of points you should consider when choosing a server host:

It should be stable. If the server goes down often then you will have an angry crowd outside your
door very soon.

1. 

Ideally it would have plently of free RAM. If the server is heavily loaded with many RAM intensive
processes, the OS will swap out low usage applications like hlserver, and the response time to license
requests could be increased. Licenses are checked often throughout the running of an application, so if
license requests are slowed the user could experience a reduction in the application performance.

2. 

It should be on a high speed link to the served hosts. 10Mbit ethernet is perfectly OK, but PPP over a
loaded modem connection is probably not. Again, if the license checks are slowed, the application
performance will suffer.

3. 

It should be a long term installation. The license server application has a node locked license to the
server host. If you change the host, a fee may be charged for each re-issue of the server license based
on the floating licenses it servers. If you anticipate changing the host in the near future, let us know
and we will issue you a time limited license and a free re-issue when the new host is up and running.

4. 

Supported Platforms

HLServer runs on Intel based Linux, Windows and OS X platforms, and will issue licenses to Linux,
Windows and OS X applications. Servers and clients are cross-compatible, so for example, you can use a
Linux server to host licenses for Windows and OS X clients.

Command Line Args

hlserver has the following command line arguments:

-d
Run as a background daemon process. This is recommended, but applicable to Linux
installations only.

-c,<filename>
Use this config file.

-l,<num>,<days>,<log>
Number of log files, how many days between switches, and filename format string. A typical
value for this argument would be -l,4,7,hlserver-%d.log, meaning use 4 log files, switching
after a week, and cycle between hlserver-0.log, hlserver-1.log, hlserver-2.log and
hlserver-3.log.
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Server Setup

To correctly install and run hlserver you should follow these steps:

Install and run HLServer. See the OS specific chapters for details; Windows, Linux, OS X.1. 

Email your vendor the code string generated by HLManager when you connect up to the license
server.

2. 

When you receive your license keys, you will need to add then to the keys file on the server; you can
use the HLManager 'add' command to do this.

3. 

Pass on to your users the information in Application Config so they can configure their software
installs to access the floating license server.

4. 

If your users encounter any problems accessing the floating licenses, see Trouble Shooting for steps you can
follow to track down the problem.
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Linux Server Setup

Typically you'll want be root and extract the TGZ file into /usr/local, though that's not a strict requirement. If
you install into somewhere other than /usr/local/hlserver, you'll need to change the HEADUS_HOME variable
in the hlserver setup files.

 cd /usr/local; tar xvzfo /where-you-saved-it/hlserver-f13-v2.*.tgz

HLServer versions up to v2.05 use /usr/tmp to save a PID file when running. If /usr/tmp doesn't exist,
then HLServer may start, but will exit soon after. Creating a symbolic link from /tmp to /usr/tmp will
fix this problem for those earlier releases.

The following files make up the Linux license server installation:

hlserver 
This is the server application. It need not be run with any special privileges unless the PORT
used is under 1027.

hlserver.conf 
The contents of this file, explained in detail in Server Config, controls the behavior of the
server.

hlserver.log 
This is a series of date stamped log messages from the server showing, amongst other things,
who is grabbing which licenses.

setup.redhat 
This is a RedHat/Fedora script that can be used to start the server on 'init' based boots, and
stop it on shutdown. Installation instructions are in the file.

setup.systemd 
This can be used to start the server on 'systemd' based boots. Installation instructions are in
the file.

setup.debian 
Start/stop script for Debian/Ubuntu based systems. Installation instructions are in the file.

hlmanager 
This is the manager application. See The Manager chapter for details.

keys.txt 
This file holds the floating license keys. Was called .keys in earlier versions.
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Setup v2

To complete the initial setup, login as root and run hlserver from the command line ...

 /usr/local/hlserver/hlserver

You should see a message like the following ...

 hlserver: Started hlserver v2.04 2017/07/11 17:12:52 on port 11668
 hlserver: Using files and keys from '/usr/local/hlserver'
 hlserver: Running in foreground.
 hlserver: We recommend using one of the setup scripts provided to run hlserver as a background daemon.
 hlserver: Now run hlmanager to complete the installation.

Next, from another command shell window, login as a normal user and run hlmanager ...

 /usr/local/hlserver/hlmanager

You should see something like this ...

Trying architec@localhost ... Connected ... Fetching ...
Server v2.00 localhost up 00:00

  Your login has been added automatically to
  the hlserver.conf file for Manager access.
  If you want to add Manager access for other
  users, you will need to edit that file on
  the server.

----------------------------------------------

  No valid floating licenses found. Please
  email the following code to your vendor so
  new license keys can be generated.

  6JZ5 2PLM 2EB3 GM4X 3W53 CEL1 PAX8 MNKB

  Copy of above code: '/tmp/hlmanager-code.txt'

  If you've already received your license keys,
  now use the "add" command to append one at
  a time to the keys file on the server.

So email that code to your vendor to get your license keys.

In the meantime, kill the foreground 'hlserver' process, then follow the instructions in whichever 'setup.*'
script is appropriate for your system to run hlserver as a background daemon.

Once you have some keys, re-run hlmanager and use the 'add' command to append them to the keys file on the
server. You should see something like this once the keys have been added.

> add
Enter key string below ...
FMWM 6N8S 0BPS 4FXP K4GL W7H7 6JFY R8B4 8NDB JP3A
Sending key to server ...
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Updating status ...
Server v2.00 localhost up 00:05
<--------- Licenses ---------->
Name        Status    Free Used
uvlayoutv2  29 days      4    0

Users should now be able to access the license server from others systems on the local network.

Setup v1

You will need root access on the server host to do this; read the appropriate script file for full installation
instructions.

Copy sample-hlserver.conf into hlserver.conf and edit to suit your network setup. You should at least
change the IP range for the lan group.

Run 'hlserver' from the command line when first installed. You'll get a "License not found" type error, and 5
rows of hex numbers; email these to your vendor to get your license strings.

Once you have some keys, follow the instructions in whichever setup script is appropriate for your system (i.e.
hlserver.redhat, hlserver.debian or hlserver.service).
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Windows Server Setup

Login as a user with Administrator privileges, and run the EXE file.

The following files make up the Windows license server installation:

hlserver.exe 
This is the server application. It need not be run with any special privileges unless the PORT
used is under 1027.

hlserver.conf 
The contents of this file, explained in detail in Server Config, controls the behavior of the
server.

hlserver.log 
This is a series of date stamped log messages from the server showing, amongst other things,
who is grabbing which licenses.

hlserver.ini 
Edit this file to change the server start-up command line arguments.

hlmanager.exe 
This is the manager application. See The Manager chapter for details.

keys.txt 
This file holds the floating license keys.

Setup v2.10

These are the setup instructions for HLServer v2.10 and later. Setup instructions for HLServer v2.09 and
earlier are below.

After running the EXE file to install the software, you'll need to perform the following steps to get the server
going:

Click 1) Install Service; you should get a "service installed" message. (see Figure 1)1. 

Click 2) Start Service; this will start the service, configures the firewall, then displays the license
server status. The first time you do this you'll get a "License not found" type error. Email the
displayed code to your vendor to get your license key (double click to select the line, then type Ctrl-C
to copy the code).

2. 

Once you get your license key, click 3) Run HLManager, type add followed by the Enter key, then
paste the license key into the command shell window to add it to the keys file on the server. The
server status will then update and you can check if the keys have been loaded OK on the server (i.e.
the "License not found" error should go away).

3. 
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Users should now be able to access the license server from others systems on the local network.

Setup v2

These are the setup instructions for HLServer v2.00 to v2.09. Setup instructions for HLServer v1.28 and
earlier are below.

After running the EXE file to install the software, you'll need to perform the following steps to get the server
going:

Run Start -> Programs -> headus License Server -> 1) Install service; you should get a "service
installed" message.

If you get a permission denied type error at this step, right click on the Start menu option and
select "Run as Administrator" (see Figure 2).

1. 

Run 2) Start service to open up the Services control panel (see Figure 3).2. 

Double click on headus Floating License Server to bring up the Service window (see Figure 4) and
select Automatic, then OK, so that hlserver restarts whenever the system is rebooted.

3. 

Click on the Start button to start hlserver.4. 

Run 3) Run HLManager to check that hlserver is running OK; the first time you do this you'll get a
"License not found" type error. Email the displayed code to your vendor to get your license key.

Note: To cut'n'paste from the Windows command shell window, click on the icon at the top left of the
window, pick Edit->Mark from the popup menu, click'n'drag the left mouse button to select the text,
then hit the Enter key. You can then paste that text into email.

Or: The code is also written into a temporary file, and the path to that file will be displayed. You can
then attached that text file to your email.

5. 

Once you get your license key, run 3) Run HLManager again, type add followed by the Enter key,
then paste the license key into the command shell window to add it to the keys file on the server. The
server status will then update and you can check if the keys have been loaded OK on the server (i.e.
the "License not found" error should go away).

6. 

If you have a firewall installed on the server, you'll need to allow access to the port specified in the
hlserver.conf file (default 11668). See Figure 5. for the Windows Vista firewall configuration.

7. 

Users should now be able to access the license server from others systems on the local network.
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Setup v2 - Alternative

These are alternative setup instructions for HLServer v2.09 and later, to be used when the Start menu entries
can't be found.

After running the EXE file to install the software, you'll need to perform the following steps to get the server
going:

Open up the HLServer install folder, and run the add-service.exe file; you should get a "service
installed" message.

If you get a permission denied type error at this step, right click on the EXE file and select
"Run as Administrator".

1. 

Open up the Windows Services control panel.2. 

Double click on headus Floating License Server to bring up the Service window and select
Automatic, then OK, so that hlserver restarts whenever the system is rebooted.

3. 

Click on the Start button to start hlserver.4. 

Run hlmanager.exe to check that hlserver is running OK; the first time you do this you'll get a
"License not found" type error. Email the displayed code to your vendor to get your license key.

Note: To cut'n'paste from the Windows command shell window, click on the icon at the top left of the
window, pick Edit->Mark from the popup menu, click'n'drag the left mouse button to select the text,
then hit the Enter key. You can then paste that text into email.

Or: The code is also written into a temporary file, and the path to that file will be displayed. You can
then attached that text file to your email.

5. 

Once you get your license key, run hlmanager.exe again, type add followed by the Enter key, then
paste the license key into the command shell window to add it to the keys file on the server. The
server status will then update and you can check if the keys have been loaded OK on the server (i.e.
the "License not found" error should go away).

6. 

If you have a firewall installed on the server, you'll need to allow access to the port specified in the
hlserver.conf file (default 11668).

7. 

Users should now be able to access the license server from others systems on the local network.

Setup v1

After running the EXE file to install the software, you'll need to perform the following steps to get the server
going:

Edit hlserver.conf to suit your network setup. You should at least change the IP range for the lan1. 
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group, and change Administrator to your login username in the Manager group.

Edit hlserver.ini to change the command line args to suit your setup (see explanation of command
line args above). Most people should be able to get by with the defaults. If you don't move
hlserver.conf from the installation directory, then you don't need to define a '-c' config file location.

2. 

Run Start -> Programs -> headus License Server -> 1) Install service; the first time you do this
you'll get a "License not found" type error. Email the 5 rows of hex numbers to your vendor to get
your license strings.

Note: To cut'n'paste from the Windows command shell window, click on the icon at the top left of the
window, pick Edit->Mark from the popup menu, click'n'drag the left mouse button to select the text,
then hit the Enter key. You can then paste that text into email.

Or: If you are using a recent release, the hex codes are written into a temporary file, and the path to
that file will be displayed. You can then attached that text file to your email.

3. 

Once you get your licenses, run 1) Install service again, and answer "y" to the edit keys file question.
Paste the license keys provided into the keys.txt file, and save it.

4. 

Run 1) Install service one more time, but this time you should get a "service installed" message.

If you get a permission denied type error at this step, right click on the menu option and select
"Run as Administrator" (see Figure 2).

5. 

Run 2) Start service to open up the Services control panel (see Figure 3).6. 

Double click on headus Floating License Server to bring up the Service window (see Figure 4) and
select Automatic, then OK, so that hlserver restarts whenever the system is rebooted.

7. 

Click on the Start button to start hlserver.8. 

Run 3) Run HLManager to check that hlserver is running OK, and that the licenses have loaded
correctly.

If you can't get a connection, check the log files in the hlserver install folder for errors. If you see a
"Denied - manager access to user@host" message, then check that the user name listed in the error
matches that in the Manager group in hlserver.conf. Use the Services control panel to restart
hlserver if you need to make any changes to hlserver.conf. See The Manager for details.

9. 

If you have a firewall installed on the server, you'll need to allow access to the port specified in the
hlserver.conf file (default 11668). See Figure 5. for the Windows Vista firewall configuration.

10. 

Users should now be able to access the license server from others systems on the local network.

A user has reported that HLServer didn't work on his XP x64 system when IPv6 was enabled for the
Local Area Network. We haven't confirmed or fixed this yet, but keep it in mind if you also experience
problems.
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Update v1 and v2

If you already have hlserver installed, but need to install a newer version, follow these steps:

If hlserver is currently running, first inform your users that you are stopping the floating license
server, and that they should save all their work. Applications using floating licenses will exit when
hlserver is stopped.

1. 

Run 4) Stop service to open up the Services control panel; right click on headus Floating License
Server and select Stop to stop hlserver.

Note: If you have an old version of HLServer, with no Start menu options, use
"Start->Programs->Administrative Tools->Services" to open up the Services control panel.

2. 

Run 5) Remove service (or run del-service.exe) and you should get a "service removed" message.

Note: Under some versions of Windows, you may need to right click on the menu option or EXE and
select "Run as administrator".

3. 

Run 6) Uninstall software to remove the old executables, leaving your config files untouched.

Note: If you have no Start menu options for HLServer, use the system control panel's "Add/Remove
Programs" to uninstall the old version. You will most likely have to move your old config and keys
files into the new install directory too; by default its different to the older installs of HLServer.

4. 

Run the new ihlserver.exe file to install the new software.5. 

Run 1) Install service and 2) Start service to get the hlserver service installed and running.6. 

Users should now be able to access the new license server.

Figure 1. HLServer Setup
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Figure 2. Run As Administrator

Figure 3. Services Control Panel

Figure 4. headus Floating License Server
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Figure 5. Windows Vista Firewall
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OS X Server Setup

Download the TGZ file and double click it to extract the contents into the hlserver folder.

The following files make up the OS X license server installation:

hlserver 
This is the server application.

hlmanager 
This is the manager application. See The Manager chapter for details.

hlserver.conf 
The contents of this file, explained in detail in the Server Config chapter, controls the
behavior of the server.

hlserver.log 
This is a series of date stamped log messages from the server showing, amongst other things,
who is grabbing which licenses.

setup 
Installation script.

uninstall 
Remove service daemon and all files.

unload 
Unload service daemon, but leave all the files intact.

reload 
Restart the service daemon.

keys.txt 
This file holds the floating license keys. Was called .keys in earlier versions.

Setup v2

Double click the setup script to start the installation.

First you will be asked where you want to install the hlserver files, so just tap the Enter key here to accept the
default ...

If prompted, type in your password for sudo access.

Installation location (/usr/local/hlserver) ?

Next you will most likely be asked for your password for sudo access; this is so the install folder can be
created and the service daemon started ...
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sudo mkdir -p /usr/local/hlserver
Password:
sudo chown architec /usr/local/hlserver
sudo cp com.headus.hlserver.plist /Library/LaunchDaemons
sudo chown root /Library/LaunchDaemons/com.headus.hlserver.plist
sudo chmod 644 /Library/LaunchDaemons/com.headus.hlserver.plist
cp -f hlmanager hlserver hlserver.conf .keys /usr/local/hlserver
sudo launchctl unload /Library/LaunchDaemons/com.headus.hlserver.plist
sudo rm -f /tmp/hlserver.pid
sudo launchctl load /Library/LaunchDaemons/com.headus.hlserver.plist

After that, the setup script will wait for the service to start up, and then runs the hlmanager command ...

Waiting for HLServer to start ... 10 9 8
Trying HLManager ...
Trying architec@localhost ... Connected ... Fetching ...

Once hlmanager is connected, you will see something like this ...

Server v2.00 localhost up 00:00

  Your login has been added automatically to
  the hlserver.conf file for Manager access.
  If you want to add Manager access for other
  users, you will need to edit that file on
  the server.

----------------------------------------------

  No valid floating licenses found. Please
  email the following code to your vendor so
  new license keys can be generated.

  RF55 RDH4 WGA4 9P2D XECG F530 2MHX 9ZST

  Copy of above code: '/tmp/hlmanager-code.txt'

  If you've already received your license keys,
  now use the "add" command to append one at
  a time to the keys file on the server.

So email that code to your vendor to get your license keys.

Once you have some keys, re-run hlmanager and use the 'add' command to append them to the keys file on
the server. You should see something like this once the keys have been added.

> add
Enter key string below ...
FMWM 6N8S 0BPS 4FXP K4GL W7H7 6JFY R8B4 8NDB JP3A
Sending key to server ...
Updating status ...
Server v2.00 localhost up 00:05
<--------- Licenses ---------->
Name        Status    Free Used
uvlayoutv2  29 days      4    0

Users should now be able to access the license server from others systems on the local network.
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hlserver will be automatically restarted whenever the system is rebooted, and you can stop and start it via the
launchctl command.

We recommend you keep a copy of the hlmanager command, but the rest of the contents of that extracted
hlserver folder can now be deleted.

Setup v1

Double click the setup script to start the installation.

First you'll be asked to check the config file. The "GROUP lan" IP range will have been set already to
match your local network, but this may need to be adjusted if you have a more complicated setup (e.g.
multiple sub-nets in a larger campus network). Save the file, kill the window, then re-run the setup
script to continue.

1. 

Initially you wont have license keys, so at the "Do you have the keys" question type n followed by
Enter to generate the code strings. Email the 5 code strings to your vendor to get your license keys.

2. 

When you get your license keys, re-run the setup script and answer y to the "Do you have the keys"
question, then type Enter to continue and the keys file will open up in the text editor. Cut'n'paste your
license keys in, save the file, kill the window, then re-run the setup script to continue.

3. 

At the "Do you have updated license keys" question, answer n and then you'll be asked for an
installation location. By default the script will want to put the binaries and config files into
/usr/local/hlserver, but you can type in a different path at the prompt if you wish.

4. 

If the setup script runs smoothly, hlserver will be started and hlmanager is run as a final check. You should
see something like the following as output ...

 Waiting for HLServer to start ... 10 9 8 
 Trying HLManager ...
 Trying architec@localhost ...
 Server localhost up 4 seconds
 <--------- Licenses ---------->  <------------------------- Users ------------------------->
 Name        Status    Free Used  Id Hostname        User     App           Age       Idle   
 uvlayoutv2  29 days      4    0

hlserver will be automatically restarted whenever the system is rebooted, and you can stop and start it via the
launchctl command.

We recommend that you keep the hlserver folder in case you need to re-run the setup script. It can be moved
if you dont want to leave it on your Desktop or in the Downloads folder.
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Update

If you need to update your keys file (e.g. replacing temp keys with permanent ones) then re-run the setup
script and answer y to the "Do you have updated keys" question. Type Enter to edit the keys file, cut'n'paste in
the new keys, then save the file, kill the window, and re-run the setup script to restart HLServer and check the
results with HLManager.
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Server Config

The hlserver.conf file is used to control access to the server and licenses. The standard installation will be
fine for most people, but if you want to fine tune things like which users or machines can access which
licenses, then you should read the following detailed explanation of the config file.

The simplest config file looks like this:

PORT    11668
LOG     1
ACC     0
IDLE    0
BOOT    1
SUPER   0
DNS     1

GROUP   lan      192.168.0.*
GROUP   Manager  root@lan

PRODUCT *        lan

PORT
The server will listen at this port for license requests. There is no restriction on what this
number is apart from the obvious one, that it doesn't conflict with ports used by other installed
software. If you have a firewall running on the server, then you will need to open up access to
this TCP port.

LOG
Set the level of verbosity of the log files.

ACC
Set the level of access to hlmanager for normal users. See The Manager: User Mode for
details.

IDLE
Number of hours to wait before killing idle licenses. Idle licenses will occur if a user
hibernates or suspends their PC when a license is checked out, or the workstation or network
has died, and can result in "zombie" licenses being checked out but not actually used by
anyone. 20 hours is probably a safe value, allowing people to legitimately suspend their PCs
over night, while also cleaning out zombie licenses at least once a day. Setting this value to
"0" turns off the idle license kill. Requires hlserver v2.05+.

BOOT
When a user's license is booted by a manager, this is the number of minutes they are locked
out. Setting it to "0" will allow then to re-acquire a license right away if they want to keep
working.

SUPER
Set this to "1" to use the "Supervisor" mode. See below for details.
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DNS
Turn on hostname resolution in the log files. If you experience delays or timeouts between the
client and server, try setting this to "0" to turn off the hostname resolution. IP addresses will
be shown in the logs files when turned off.

GROUP
Each line of this section associates a single name with a list of hosts, prefixed with optional
user names. In the above simplest case, lan is associated with the IP range for a local area
network. The name lan can then be used to refer to all hosts in the LAN.

The * character is a shorthand way of saying 1-255; they both mean the same thing. The *
character can also be used to extend to the beginning or end, as in 45-* (equivalent to 45-255)
or *-66 (equivalent to 1-66).

The brace characters can be used to surround a list of alternatives, as in {*-45,47,49-*}
(everything except 46 and 48).

Hostnames can be used in place of IP ranges, though the list could become quite long if you
are serving a large number of hosts. IP ranges are more concise, and will avoid any possible
domain name resolution problems.

The special group Manager defines the list of users that can be trusted to run the hlmanager
application (see "The Manager" chapter for more details).

Multiple members to a group should be separated by commas, or alternatively, you can define
the group multiple times (over multiple lines) to add members.

Usernames are case-sensitive, so the default Windows hlserver.conf, with "GROUP
Manager Administrator@lan", wont give access to a user with an "administrator" login.

By the way, there's nothing stopping you from defining *.*.*.* as an IP range. The advantage
of this is that all correctly setup clients can access the server without you having to worry
about when net or subnet they're on, but the disadvantage is that anyone who has network
access to your license server can grab one of your floating licenses.

PRODUCT
In this section you should have a single line for each product that you have floating keys for,
or use * to select all products. Follow the product name with a list of hostnames or group
names that have access to that product. You can optionally prepend a username, in the form
username@host/groupname to further restrict access. If a Windows username has spaces in
it, replace those with underscore in the config file (e.g. login "Jill Smith" would need to be
written as "Jill_Smith" in the config file).

The following shows a more complex example of a config file.
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PORT              11668
LOG               1
ACC               1
IDLE              6

GROUP   cg-lab    192.168.0.1-23
GROUP   office    fred,barney
GROUP   offsite   112.56.22.{12-15,21}

GROUP   Manager   julie@office,jimbo@cg-lab,root@hlserver

# The above line and these three below do the same thing

GROUP   Manager   julie@office
GROUP   Manager   jimbo@cg-lab
GROUP   Manager   root@hlserver

PRODUCT cyslicev3 cg-lab,{phil,jill}@offsite
PRODUCT plyedit   jimbo@cg-lab

Anyone currently logged into a cg-lab machine can request a cyslicev3 license, but only phil or jill can from
the handful of offsite machines. Whenever jimbo is logged into a cg-lab machine, he can request a cyslicev3
or plyedit license as well as run the license manager.

Keys

Floating licenses, stored in the .keys or keys.txt file, look something like this:

   Products   System         Expire          Num
 # uvlayoutv2 sysid=690ca1ab expire=101226 [000 4]
 8MFP LCDY A0GZ 553N QQ6Z BLMB A1A6 GF1G # 6200
 74QX SEPD GEC4 AK1W QJK8 3E5N 2LLF 345C JQX5 24SA # 6201

You might also have the older style license keys that look like this:

      <- 21 hex numbers ->   Product   System   Expire Ref#   Num
 #v2# 3a d6 ........ a9 42 # cysurf    690ca1ab never  0920 [001 3]
 #v2# 5d da ........ 32 6a # cyslicev3 690ca1ab never  0921 [001 1]
 #v2# 37 db ........ 71 5b # cyslicev3 690ca1ab 110216 0922 [002 1]

The Product names go into the config products section, System is the sysid of the license server, Expire is
when each floating license runs out, Ref# is a database reference number used by the issuer, and Num is the
sequence id and number of floating licenses in that key.

In the first example there are 4 uvlayoutv2 floating licenses.

In the second example above, there is 1 cyslicev3 and 3 cysurf floating licenses that will never expire, and 1
additional cyslicev3 license that runs out on the 16th of Feb, 2011. Even though there are multiple cyslicev3
keys, you would normally only have one cyslicev3 access list in the config products section.
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Supervisor Mode

Requires hlserver v2.04+.

Normally HLServer runs as a single process. On the rare occasions that a bug causes this process to crash, the
license server will no longer be operating, so users won't be able to get licenses to run their applications.

When in supervisor mode though, there's two processes running. The worker process is the one doing all the
work, serving out all the licenses, where the supervisor process is simply watching the worker. If the worker
crashes, the supervisor starts up a new worker process.

If combined with supported client software (i.e. UVLayout v2.10.01+) the end user will not know that
anything has happened. Earlier client software versions will however still lose their license (from the first
worker process) and users will need to re-run their software to get a new license from the new worker process.

Because its a brand new feature, this supervisor mode is turned off by default, and we'd only recommend
using it currently if you were experiencing occasional hlserver crashes.

Partitioning

Requires hlserver v1.15+.

In the examples shown to this point, all licenses for a particular product are available to all the users listed on
the PRODUCT line. For example, in the following config file all of the uvlayoutv2 licenses are available to
everyone from cg-lab and offsite:

GROUP   cg-lab    192.168.0.1-23
GROUP   offsite   112.56.22.{12-15,21-*}

PRODUCT uvlayoutv2 cg-lab,offsite

With partitioning, you can allocate a different number of licenses to the different groups. In the following
example, 10 licenses in total are available (this is determined by your license keys), but 7 have been reserved
for users from cg-lab, and 3 for offsite users:

PRODUCT uvlayoutv2 cg-lab[7],offsite[3]

The number inside the square brackets defines the number of licenses allocated to that group. In the above
example, if a fourth offsite user tries to grab a license, they will be denied access, even if none of the cg-lab
licenses have been used.

You can also choose to restrict some groups but not others. In the following example, offsite users are
restricted to 3 licenses maximum, but cg-lab users could grab all of the 10 licenses if they are free.

PRODUCT uvlayoutv2 cg-lab,offsite[3]

Another way to define the above partitioning is via the use of negative allocations. In the following example,
offsite users can have all but 7 of them, or in other words, cg-lab users are guaranteed to have at least 7

headus HLServer v2.11 User Guide 08 Mar 2022

 Supervisor Mode 21



licenses:

PRODUCT uvlayoutv2 cg-lab,offsite[-7]

License Key Groups

You can also partition according to license key groups. In the following keys file there are two groups, a pair
of permanent keys with an ID of 000, and 4 temp keys with an ID of 001. You can find this information inside
the square brackets:

# hlserver,uvlayoutv2 sysid=5b83f8dd expire=perm [000 2]
R6LZ PF0Q HZ65 8H55 463T E69W 07WF 5R9C # 10395
NTRC 4H24 5R9C 1KZF RJ0Y C0CW 8H55 G1SE 76GZ F6AA # 10396
# uvlayoutv2 sysid=5b83f8dd expire=100602 [001 4]
F913 2LLB 71WC 71FG PF0Q XYPL WAYH HCTQ D7PA 6RAA # 10398

To allocated each of the key groups to different groups within the config file, create multiple PRODUCT
lines and append the key group ID to the product name, separated by a period character. In the following
example, users from cg-lab are allocated the 2 permanent keys, and users from offsite get the 4 temporary
keys:

PRODUCT uvlayoutv2.000 cg-lab
PRODUCT uvlayoutv2.001 offsite

You can combine all partitioning methods if you wish. In the following example, users from cg-lab are
guaranteed their 2 permanent key, but can also grab up to 2 of the temporary keys if they are free.

PRODUCT uvlayoutv2.000 cg-lab
PRODUCT uvlayoutv2.001 offsite,cg-lab[2]

Client Side Groups

Requires hlserver v1.16+.

In some environments, such as those using DHCP to assign IPs, partitioning using a static list of IP addresses
is not feasible. You might then use usernames to control access, but if people are regularly being moved
between projects with different access rights, keeping the config file in sync can be a hassle. In these cases
you can use client side groups to control access.

In the following example, two groups are defined with the exact same IP ranges, and then access to the two
license key groups is partitioned according to the two group names:

GROUP   teamA   192.168.0.*
GROUP   teamB   192.168.0.*

PRODUCT uvlayoutv2.000 teamA
PRODUCT uvlayoutv2.001 teamB
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Just by itself, this config would allow all users access to all licenses, so what you also need to do is allocate
users to their groups on the client side via the HEADUS_HLGROUP environment variable. In the above
example, setting the value of HEADUS_HLGROUP to "teamA" would then allow that user to access the
"uvlayoutv2.000" licenses only.

Under Windows, 'Group Policy Objects' can be used to assign HEADUS_HLGROUP definitions to each user.
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Application Config

Applications using floating licenses are installed as they normally would be on the client workstations. Its
perfectly OK to also use NFS or some similar network file system to share files.

When an application is run, and if no local key is found, the license server is contacted. If no local or floating
licenses are available, the application will not start and the headus licensing GUI will start up.

If you ever need to start the licensing GUI directly, use one of the following ways:

Run headus from the command line (Linux or OS X only).1. 
Run Start->Programs->Application->License (Windows only).2. 

Newer GUI

These are the config instructions for applications built from about September 2017; see the section below for
older applications.

If the user's workstation or laptop is on the same subnet as the license server, and you've configured HLServer
with the default of "PORT 11668" in hlserver.conf, then they can click on the blue "?" button to search for the
license server.

If the server can't be found, or is on a different subnet, then users will need to type the server IP address into
the Server field, then click the blue "?" button to test the connection.

Once the server has been set, the "?" changes to a right arrow; it will have four different colors:

Black 
Server found, and click arrow to run HLManager.

Green 
Server found, licenses available, but user doesn't have HLManager access.

Orange 
Server found, but no licenses available and no HLManager access.

Red 
No license server found at that address.

Older GUI

To get the older applications to talk to the license server, click on the Common Preferences button (see Fig
2). Enter host into the HLServer field (where host is the hostname or IP address of your license server).
Click the Update button to check that the floating licenses have been found.

Note: Normally the host port number can be left off if you use the default of "PORT 11668" in hlserver.conf.
If a different port has been used, or you are using older client applications, then it needs to be added to the
hostname with a colon, as in host:port (e.g. "lserver:11668").
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Environment Variable

If you are a systems admin wanting to set the license server host for all of your users, then you can use the
HEADUS_HLSERVER environment variable as an alternate to the method described above. If installing
onto OS X or Linux, you can put your setenv commands into /etc/csh.headus, and the start-up scripts will
then run in that environment. An example /etc/csh.headus would look like:

 setenv HEADUS_HLSERVER lserver

Alternatively, put the name of the license server into a file called hlserver.txt, and put that into the "lib"
folder where the client software (e.g. UVLayout) is installed. It should be in the same location as the empty
keys.txt file. An example hlserver.txt would just say:

 lserver

Application Restore

The link between the license server and applications is via connected TCP/IP sockets. This means that a
connection has to be maintained at all times during the life of an application. If the connection is dropped,
then the application loses its license, and the default action is for it to exit without warning.

Possible reasons for a broken connection are:

Server crash/reboot. The server that allocates the floating licenses crashes, loses power, or is
rebooted for some other reason.

1. 

HLServer crash/restart. The floating license software, running on the server, crashes or is restarted
for some other reason. Note: HLServer doesn't need to be restarted to activate changes made to the
config or keys files; the hlmanager "reload" command should be used for this.

2. 

HLServer boot. A user with hlmanager access has "booted" the license.3. 

The restore function allows users to define a directory where all current work is saved when a license is lost,
and the application can be restarted from this save point. Note: Currently only CySlice and associated
products (.i.e PlyEdit, CySize, UVLayout) support the restore function.

To set the restore directory, each user needs to run the headus licensing GUI using one of the following ways:

Run the application, click About, click Run Licensing GUI.1. 
Run headus from the command line (Linux or OS X only).2. 
Run Start->Programs->Application->License (Windows only).3. 

Once the licensing GUI is running, click on the Common Preferences button (see Fig 3). A directory name
can then be entered into the Restore Dir text field; hit <Enter> to save the change.
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The restore directory should be on a local drive, not a networked drive/share, in case the loss of license is
through a network problem or server reboot. The selected directory should also be one that's maintained
through a reboot of the local system; RAM drives and temporary areas that are cleaned out on reboot shouldn't
be used.

Once the restore directory has been defined, applications run from then on are protected by the restore
function. If a license is lost, the application dies as per usual, but a restore window will then appear (see Fig
4).

If a user sees this window, they should first talk to a systems administrator to determine the cause of the loss
of the license. If a server is down, they will need to wait until that is rebooted before trying to restore the
application. If HLServer is down, that will need to be restarted.

When all services have been restored, the user can click on the Restore button; the application they were
running will be restarted, and all saved work is reloaded. Once all that is up and running, the restore files can
be removed with the Delete Files button.

If for some reason the restore window is killed before the user is able restore the application, they still have
one more chance to recover all their work. Open up the most recent restore*.txt file in the assigned restore
directory, and look for the "Can restore with ..." line; follow the instructions to manually run the restore
function. And if that fails for any reason, the data files themselves will also still be in the restore directory; the
application can be started as it normally is, and these file manually loaded to recover the lost work.

Fig 1. Setting Server - New
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Fig 2. Setting Server - Old

Fig 3. Setting Restore Directory

Fig 4. Application Restore Window
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The Manager

Sysadmins and trusted users (i.e. users listed under the Manager group) can use the license manager to check
the status of the license server, to see which licenses are being used, to reclaim licenses and so on.

You can find the hlmanager application in the hlserver install folder on the server, but under Windows it can
be run from the Start->Programs->headus License Server menu too.

The hlmanager application can also be run from other hosts, if you have one of the client applications
installed on that host (.e.g. CySlice, UVLayout). Run the licensing GUI, then click on the arrow to the right of
Floating Keys to start hlmanager (see Figure 1). Make sure that the "Manager" line in hlserver.conf allows
access for the remote host and user.

Sometimes under Windows Server 2003, hlmanager can only be run from another host.

Adding Manager Users

Depending on how the license server is configured, users without full access may be allowed limited manger
access, or locked out completely.

If you need full manager access from a particular login, you'll need to add a "GROUP Manager
<username>@lan" line to the hlserver.conf file on the server. Using the correct username is critical for
enabling full manager access.

Depending on whether you currently have limited or no access, see the appropriate section below for how to
find out that username.

Limited Manager Access

If you have limited manager access, you'll see the following warning when you launch hlmanager ...

Trying architec@lserver ... Connected [0.3s], Fetching ... [0.4s]
**  Limited manager access only.  **

To find out what username you need to use, check the latest hlserver log file on the license server. Search for
the last "Connect - manager" line, which will look something like this ...

hlserver: ... Connect - manager user architec@client
                                     ^^^^^^^^

Its the username before the "@" symbol that you need to use, exactly as shown in the log file. You would then
add the following line to the hlserver.conf file, replacing "architec" with your username, then restart the
hlserver service to activate the configuration change. Once you have full access, you should use the hlmanager
"reload" command to load future changes to the config file.
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              vvvvvvvv
GROUP Manager architec@lan

No Manager Access - Old

If you have no manager access, you'll see the following error when you launch older versions of hlmanager ...

Trying architec@lserver ... [0.3s]
hlmanager: Problems connecting to license server lserver.

Unfortunately there's no way to know in the older version if the connection has succeeded, but access is
denied, or if there's also a general problem with the connection to the server.

Assuming the connection is OK, check the latest hlserver log file on the license server. Search for the last
"Denied - manager" line, which will look something like this ...

hlserver: ... Denied  - manager access to architec@client hlmanager
                                          ^^^^^^^^

Its the username before the "@" symbol that you need to use, exactly as shown in the log file. You would then
add the following line to the hlserver.conf file, replacing "architec" with your username, then restart the
hlserver service to activate the configuration change. Once you have full access, you should use the hlmanager
"reload" command to load future changes to the config file.

              vvvvvvvv
GROUP Manager architec@lan

No Manager Access - New

If you have no manager access, you'll see the following error when you launch newer versions of hlmanager
...

Trying architec@lserver ... [0.2s]
Manager access denied to license server lserver.

To get access, add this line to the
hlserver.conf file on the server ...

   GROUP Manager architec@lan

... and restart the hlserver service
to activate the configuration change.

Once you have access, you should use 
the hlmanager "reload" command to load
future changes to the config file.

Hit <Enter> to continue ...
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Its the "GROUP Manager" line, exactly as shown in the error message, that you need to add to the
hlserver.conf file, then restart the hlserver service to activate the configuration change. Once you have full
access, you should use the hlmanager "reload" command to load future changes to the config file.

Using HLManager

When first started up, something like the following will be displayed:

Server roley:11668 up 19 minutes and 46 seconds
<--------- Licenses ---------->  <------------------- Users ------------------>
Name        Status    Free Used  Id Hostname User     App       Age      Idle   
cyslicev2   23 days      0    1   1 roley    architec cyslice  0:16.53  0:05.40
                                             architec cyeat    0:16.48  0:06.45
cyslicev2   <1 day       1    0
cysurf      permanent    3    0
plyedit     <1 day       1    0
decimate    18 days      1    1   2 lunacy   architec mtool   11:23.14 11:23.13

Note: If you're running the Windows version, the default console window may be too narrow, wrapping the
longer lines around and making the display rather confusing. You can fix this by:

Right click on the console window title bar, and select Properties.1. 
Click on the Layout tab, and change both the buffer width and window width to 93.2. 
Click on OK, pick Modify shortcut, then OK finally to make the change permanent.3. 

The first line of the status report tells you where the server is and how long its been up.

The Licenses section lists all available licenses: in the example there is one cyslicev2 license with 23 days
left, another cyslicev2 license with less than 1 day left, three permanent cysurf licenses, one plyedit license
also about to expire, and two decimate licenses with 18 days to expirey.

The Users section lists all currently used licenses: in the example there is one of the cyslicev2 licenses being
used on roley by architec, and architec also has a decimate license on lunacy.

You can see that the license name and application names don't always match. For example, the decimate
license has been grabbed by the mtool application. When mtool starts up it'll grab a decimate license, if one is
free, so that the Decimate panel can be enabled. If no decimate license is available, it'll look for other licenses
from CySurf, CySlice, CyDir and finally, as a last resort, Mtool.

The Age and Idle columns show how long ago a license was grabbed, and for how long the application has
been idle. In the example it looks like CySlice was started about 15 minutes ago, and hasn't been used for the
last 5 minutes. The Mtool application was started over 11 hours ago and hasnt been used since; its a likely
candidate for a "boot" if you run out of decimate licenses.

After the initial status listing, you will be presented with a command prompt where you can type one of the
following commands:
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<Enter>
Display current status. The status listing doesn't update by itself as licenses come and go. You
need to hit <Enter> whenever you want it refreshed.

add
Add a license key to the keys file on the server. HLServer v2 installs only.

last <num>
Show the last num lines of the log file. If you leave off the num, it defaults to 10 lines.

conf
Show the contents of the hlserver.conf file, with all commented lines stripped out.

keys
Show the contents of the floating keys file installed onto server

reload
Tell the server to reload its keys and config files. You will need to do this if you edit these
files while the server is running.

boot <id>
Release a license, making it free for other users to access. Get the id number from the Id
column in the status listing.

boot me
Release all of your own licenses, leaving others untouched.

shutdown
Tell the server to shut itself down.

quit
Quit from the manager application.

?
Show the command help.

Command Line Access

All of the above hlmanager commands can be run from the command line.

Some examples:

Reload the config file after any change:
hlmanager reload

Get the current status:
hlmanager status

Get a list of current CySlice users:
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hlmanager status | grep ' cyslice' | cut -c37-60 | \
sort -u | awk '{print $2 "@" $1;}'

User Mode

There are 3 possible levels of access to hlmanager for normal (non Manager) users. This level of access is
set globally in the hlserver.conf file with the ACC parameter. Requires hlserver v1.7+.

0 - No access 
Only users listed in the Manager group can run hlmanager.

1 - Self only 
Users can only see and boot their own licenses. In the situation where two users might share a
license and one boots it (e.g. two different users are running CySlice on the same
workstation), only the user running the boot command loses their license. This will not free
up that license, because the other user will still be using it.

2 - Others OK 
Users can see all licenses, but only boot their own. In the situation where two users share a
license, both will lose their license if one boots it. This will free up that license.

Figure 1. Running HLManager from the GUI
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Adding New Keys

Occasionally you may receive a new or updated license key that needs to be added to a running hlserver
process. 

Adding New Keys

If you're simply adding a new key to an existing product, then ...

HLServer v2 
Use the HLManager add command to append new keys to the keys file on the server.

HLServer v1 
Edit the keys file on the server and add the key string to the end of the file, then use the HLManager
reload command to load up the new key.

If the new key is extending the duration of an old key, there is no need to delete the old one; the new key will
over-ride the old one.

If you've run HLManager from an application licensing GUI, then you will need to quit and restart that
licensing GUI for it to recognize the updated keys. Unfortunately clicking the Refresh button doesn't
currently work, but it will do in the next release.

Adding New Products

Older floating license keys look like this ...

     <- 21 hex numbers ->    Product     Sysid    Expire Ref#   Num
#v2# 3a d6 ........ a9 42 #  uvlayoutv2  690ca1ab never  0920 [001 3]

The first word after the # character is the product name for that license.

More recent floating licenses look like this ...

# hlserver,uvlayoutv2 sysid=690ca1ab expire=071226 [000 4]
8MFP LCDY A0GZ 553N QQ6Z BLMB A1A6 GF1G # 6200
74QX SEPD GEC4 AK1W QJK8 3E5N 2LLF 345C JQX5 24SA # 6201

In this form there will be one or more products listed after hlserver.

You will need a PRODUCT line in your hlserver.conf file for each product covered by these license keys.
For example, with both the old and new license formats above, this line will need to be added to the
hlserver.conf file ...

PRODUCT uvlayoutv2 <access_list>

More information on the format of the hlserver.conf file can be found in Server Install: Configuration.
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Reloading Files

Whenever you make a change to the keys file or hlserver.conf, you'll need to tell hlserver to reload these
files. You can do this via the hlmanager "reload" command. More information on hlmanager can be found
in The Manager.
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Trouble Shooting

If you can't get HLServer to work, you should first check the server log file for any obvious errors. If that's no
help, check below for some tests you can run on both the server and client machines. 

Server Log

The first stop for all problems is the hlserver log file, found in the hlserver install directory on the server. By
default there will be two log files, rotated weekly; check their last modified dates to see which one is currently
active.

If your users have problems accessing the floating licenses, you should first check the log file to see if any
errors have been reported. The following is an explanation of the log messages.

Config - Couldnt find config file
The config file wasn't found. (Linix) Check the server startup script for the correct setting of
the HEADUS_HOME variable. (Windows) Check hlserver.ini for correct setting of "-c"
argument. (OS X) Have you run the setup script?

Config - Problems reading config file
The config file was found, but it couldn't be opened for reading. Check file permissions.

Config - starting hlserver
So far so good.

Connect - INVALID: host [xxx.xxx.xxx.xxx]
Someone from host (with IP xxx.xxx.xxx.xxx) connected to the server's port, but it wasn't
talking the right protocol. This could mean one of a couple of things; there's some sort of port
overlap with other installed software; you can change the PORT used by hlserver by editing
the config file and restarting. Or someone's doing a port scan attack to find a way into the
system; you might need to install a firewall, or if you already have one, configure it to block
connects to port 11668 from outside the LAN.

Connect - INVALID: host [xxx.xxx.xxx.xxx] using newer protocol
This will appear if someone on host is trying to run an application that's compiled with a
newer incompatible version of the license request protocol. This means you need to install a
newer version of hlserver.

Connect - manager login user@host
user@host is running hlmanager.

Denied - manager access to user@host hlmanager
user@host tried to run hlmanager without access being given in the config file.

Denied - access to user@host appname
user@host, running appname, tried to grab a floating license without access being given in
the config file.
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DeniedIP ip [range] - access to user@host appname
user@host, running appname, tried to grab a floating license, but their ip was out of the
allowed range. Check the IP ranges defined in the config file.

DeniedCG [name] - access to user@host appname
user@host was denied access because of a client side group definition.

Reload - by user@host
Manager user@host told hlserver to reload its key and config files. This would need to be
done whenever the files have been edited while the server is running.

Grabbed - product user@host appname
user@host, running appname, grabbed one of the product floating licenses.

Attach - product user@host appname
user@host, running appname, attached to an existing product floating licenses.

Freed - product from host
All applications on host using the product floating license have exited, and so its freed for
others to use.

Booted - product on host by user@host
Manager user@host told hlserver to withdraw the product floating license from host.

Lost - product for host
This would occur after a server reload if a change in the key or config files have withdraw
access to product for host.

Shutdown - by user@host
Manager user@host told hlserver to shut itself down.

Shutdown - at server
hlserver shut itself down. Under Windows that would usually be because the service was
stopped. Under IRIX/Linux it could happen if the hlserver process couldn't write to
/usr/tmp/hlserver.pid, or if two hlserver processes tried to run at the same time, or if the PID
file is deleted manually or via a cron job.

Checking the Server

If the log file recorded no errors, you can run these tests to check that the server is running OK.

Look for hlserver in the list of running processes (Linux, OS X) or services (Windows). If its not
there, have another read of the setup instructions (Linux, Windows or OS X) to make sure you've
done all that's required.

1. 

Run hlmanager, and check that the licenses have been loaded. If hlmanager can't connect to hlserver,
check the log file for possible problems. If hlmanager runs OK, but no licenses are listed, check the
keys file for possible problems. Each key should be on a single separate line, with no leading spaces

2. 
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or tabs.

Checking Clients

You can run these tests to check that the client (i.e. user) is configured properly.

Run the headus licensing GUI and check that there's a "Floating Keys" entry above the "Hardware
Keys" label. If not, then the HLServer setting hasn't been defined properly; check Application Config
for details.

1. 

Are any valid (i.e. green colored) licenses shown in the "about headus 3D tools" window? If yes, then
the client is talking to the server OK. Click on the Test button next to the application you are having
problems with; if it works, but your other methods for starting the application fail, check your
methods. If the test doesn't work, check the hlserver log file for errors.

2. 

If no valid licenses are shown in the "about headus 3D tools" window, then you need to check the
TCP/IP connection between the client and hlserver. You can do this by running telnet from the client
side; use the command line so you can define the port to connect to. That is, run "telnet server 11668",
where server is the name of the host running hlserver.

If all is OK then nothing will happen; hit enter and telnet will exit. The log file should show a
"Connect - INVALID" error, which is what's its supposed to do.

If, on the other hand, telnet gives an error, that'll indicate there's some problem with the TCP/IP
connection between the client and hlserver. It might be that the server itself is blocking connects to
that PORT; if you are running a firewall, check its settings. It might be that the client is confused
about who server really is; run "ping server" from the client side and check the IP address.

3. 

If you have a "Build Status Report" button in the headus licensing GUI, click that for more debugging
information.

4. 

If none of the above tests sheds any more light on the problem, contact your vendor for further directions, and
attach the status report if you have one from step 4 above.
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Notes
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